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ComponentOne Chart for WPF
Overview

Component One ChartE for WPF revol uti &~ Getting Started
powerful rendering, rich styling elements, animations, and dafsinding
capabilities. Display your chart in a Smart Client application or take advaage of If you're new to Chart
the XBAP support and extend your deployment capabilities to the Web. for WPF, get started
] o ] with the following
With the built-in themes, chart types, and wide range of color palettes your topics:
customized chart is just clicks awag no additional coding required. Combine the
simplicity of Chart for WPF with the power of WPF and you'll discover creating - Chart for WPF
professionally designed chart types has never been easier. %LS'EEM(DaQG
- Chart Types(page
66)
- Chart Data Series
(page94)

What's New in ComponentOne Chart for WPF

This documentation was last revised fo2011v2 on June 14 2011
New Features
The following new features were added t€omponentOne Chart for W PF in the 2011 v2 release:
1 Added new enhancements to the ChartPanel Object
1 Added protected method, ChafPanelObject.OnDataPointChanged

1 ChartPanelObject.AxisX and ChartPanelObject.AxisY properties were added support auxliary
axes.

1 Chart panel objects are hidden when its position is outside the plot area

Added ChartPanelObject.UseAxisLimits property. When UseAxisLimits = true the object can not be
moved outside the plot area.

I Axis improvements
1 Added GetAxisRect method that returns axis rectangle in chart control coordinates.
1 Added Axis.UseExactLimits that allows to turn off rounding for axis minimum and maximum.
1 Enabled caching for plot elements in .NET 4.0
Added CacheModeproperty that gets or sets the cache mode for plot elements. Only for .Net 4.
New Members

The following members were added t€hart for WPF in the 2011 v2 release:

Member Description




OnDataPo intChanged
AxisX
AxisY

UseAxisLimits
GetAxisRect

UseExactLimits

CacheMode

New Topics

Called when the data point was changed.

Gets or sets the name of the X - Axis.

Gets or sets the name of the Y - Axis.

When UseAxisLimits = true, the object
can not be moved outside the plot area.

Gets the coordinates of the axis
rectangle.

Specifies whether to use exact data
value s for axis minimum and maximum.
By default(UseExactLimits=false), the
minimum and maximum can be adjusted
to round numbers.

Gets or sets the cache mode for plot
elements. Only for .Net 4.

The following new topics were added t&€hart for WPF:

New Topic

Using MVVM _(page 153)

XAML Quick Reference (page 42)

New Task-Based Help Topics

Description

Shows how to use C1Chart in a MVVM designed
application.

Shows how to use the WPF C1Chart using only
XAML code.

The following task-based help topics were added ©Ghart for WPF :

Task -Based Help Topic

Adding a Bar Series and a Line Series
at the Same Time _ (page 168)

Adding Connecting Lines to Prevent Pie

Overlapping _ (page 172)

Changing the Candle Stick Width (page
165)

Changing the Offset for All Slices (page
172)

Creating a HiLoOpenClose Chart (page

170)

Creating a Gaussian Curve _ (page 169)
Displaying Axis Labels on an Angle

(page 159)

Hiding the Chart Legend (page 162)

Orienting the Data in the ChartL egend
(page 163)

Scaling a Bubble Chart While Zooming
(page 166)

Scaling Both Independent Axes (page

Description

Shows how to programatically add a Bar series
and a Line series at the same tim e..

Shows how to add connecting lines using XAML
code to prevent the Pie from overlapping.

Shows how to programatically change the candle
stick width.

Shows how to programatically change the offset
for all slices in the Pie chart.

Shows how to programmatically create a
HiLoOpenClose chart.

Shows how to programatically create a Gaussian
Curve.

Shows how to programmatically display the axis
labels on an angle.

Shows how to use xaml to hide the chart legend.

Shows how to orient
horizontally.

the chart legend

Shows how to adjust the scale in the
DataSeries.PlotElementLoaded event to scale the
Bubbl e chart while zooming.

Shows how to scale both independent axes

10



167) the C1Chart.PropertyChanged event

Swapping X and Y Axes During Shows how to invert the X and Y axes after the
Runtime (page 167) chart was loaded.

Exporting Chart into a PDF Format Shows how to programatically export chart into a
(page 175) PDF format.

Setting the Default Viewing Angle for Shows how to programatically set the default

3D Pie Chart (page 173) viewing angle for the 3D Pie chart.

Specifying the Color of Each Shows how t o programatically  specify the color
Bar/Column in the Data Series (page of each bar/column in the datat series

165) DataSeries.PlotElementLoaded event

Zooming in C1Chart  (page 167) Shows how to add zooming beh avior in C1Chart.

Tip: A version history containing a list of new features, improvements, fixes, and changes for each product is
available on the ComponentOne Website at http://helpcentral.componentone.com/VersionHistory.aspx.

Revision History

The revision history provides recent enhancements @hart for WPF .

What 6s New in 2011 v1
This documentation was lasrevised for 2011 v1 on February 22, 2011.
The following new features were added t€omponentOne Chart for W PF in the 2011 v1 release:
1 New Chart Types Added
Added Polygon and PolygonFilled chart types

These are simialr to line/area, but they create a cded area defined by data points. These chart types
(especiallyPolygonFilled) can be very handy when you need to add a zone with custom shape.

1 Add Ul Elements Over the Chart

Added ChartPanel and ChartPanelObject classes that allows to position Ul elementsver the chart using
data coordinates. For more information on these classes eleart Panel(page95).

The following image illustrates the ChartPanelObjects:

11
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1 Add Symbols to Non-Symbol Charts

You can now apply DataSeries.SymbolMarker to non-symbol charts such as Area, Line, and Step.

1 Enhanced PlotArea Appearance

You can now add definitions inXAML using the ChartView PlotAreaColumnDefinitions and
PlotAreaRowDefinitions . For more information seePlot Area Appearance(pagell6).

The following image illustratesthe ChartView PlotAreaColumnDefinitions and
PlotAreaRowDefinitions used to get the background colors for each plot area:

0 20 40 60 80 100 2 4 6 8 10
w1 e

1 New Chart Samples

Added the following new samples for the new features: AdvanceBolygon, Interaction\ AddRemove
Markers, Interaction\ Markders, Interaction\ Mouse Marker, Combination\ Plot Areas (vertically).

1 Multiple Plot Areas

12



Added multiple plot areas (PlotArea class, ChartView.PlotAreas and As.PlotArealndex properties)
1 New Font Properties

Added font properties for theAxis class(FontFamily, FontSize, FontStyle, FontStretch, FontWeight).
1 Fast Render Mode

The rendering mode is controlled by th&®@enderModepropetty. The new rendering method shows a good
performance with scatter charts.

1 Enhanced Symbol Charts

Added LineAreaOptions.OptimizationRadiusScope property and corresponding enum. The
optimization can be applied to the symbol charts

The LineAreaOptions.Optimi zationRadius can be set on the data series
1 Axis Label Positioning
Improved axis label positioning for small time intervals

T New Icons

What 6s New in 2010 v3
This documentation was last revised for 2010 v3 on October 21, 2010.
Designtime support forC1Chart3D has been added. See ti@omponentOne 3D Chart for WPF documentation
for more information on this new control.
What's New in 2010 v2
New changes have been added @omponentOne Chart for WPF in the 2010 v2 release:
New Changes
The following changes wereadded toComponentOne Chart for W PF in the 2010 v2 release:

1 The following properties ofAxis class now are dependency propertieAnnoPosition , LogBase,
MajorUnit , MinorUnit , Position, and Scale

Installin@€harforWPF

The following sections provide helpful information on installingChart for WPF.

Chartfor WPFSetup Files

The installation program will create the directoryC:\ Program Files\ ComponentOne\ Studio for WPF, which
contains the following subdirectories:

bin Contains copies of allComponentOnebinaries (DLLs, EXES). For
Chart for WPF , the following .dlls are installed:

C1.WPF.C1Chart.Design.dll
C1.WPF.C1Chart.dll
C1.WPF.C1Chart.Extended.dll
C1.WPF.C1Chart3D.dll
C1.WPF.C1Chart.Expression.Design.dll

13



C1.WPF.C1Chart.VisualStudio.Design.dll
C1.WPF.C1Chart.Design.4.0.dll

H2Help Contains Microsoft Help 2.0 integrated documentation for all Studio
components
C1Chart\ XAML Contains the full XAML definitions of C1Chartstyles and templates

which can be used for creating your own custom styles and template

The ComponentOne Studio for WPF Help Setup program installs integrated Microsoft Help 2.0 and Microsoft
Help Viewer help to the C\ Program Files ComponentOné Studio for WPF directory in the following
folders:

H2Help Contains Microsoft Help 2.0 integrated documentation for all Studio
components
HelpViewer Contains Microsoft Help Viewer Visual Studio 2010 integrated

documentation for all Studio components.

Samples

Samples for the prodat are installed in theComponentOne Samplesfolder by default. The path of the
ComponentOne Samplesdirectory is slightly different on Windows XP and Windows7/ Vista machines:

Windows XP path : C:\ Documents and Settings<username> My Documents\ ComponentOneSamples

Windows 7/ Vista path: C:\ Users <usernamex Documents. ComponentOne Samples

The ComponentOne Samplesfolder contains the following subdirectories:

Common Contains support and data files that are used by many of the demo
programs.
Ci1Chart Contains amples forChart for WPF .

Samples can be accessed from tB®@mponentOne Studio for WPF Control Explorer. On your desktop, click the
Start button and then clickAll Programs| ComponentOne | Studio for WPF | CIWPFChart Samples .

System Requirements

System regiirements include the following:

Operating Systems: Microsoft Windows® XP with Service Pack 2 (SP2)
Windows VistaE
Windows ServeN 2003
Windows Server 2008
Windows 7
Environments: .NET Framework 3.5 or later

Visual Studio® 2005 extensions for .NET Framewrk 2.0
November 2006 CTP
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Microsoft ® Expression® Chart for WPF has special desigtime support for Blend which
Blend Compatibility : includes workarounds for correct XAML seriaization and a
customizable user interface.

Note: The C1.WPF.VisualStudio.Des ign.dll  assembly is required by Visual Studio 2008 and the
C1.WPF.Expression.Design.dll assembly is required by Expression Blend. The C1.WPF.Expression.Design.dll
and C1.WPF.VisualStudio.Design.dll assemblies installed with Chart for WPF should always be p laced in the

same folderas C1.WPF. Cl1Chart. dll ;the DLLs should not be placed in the Global Assembly Cache (GAC).

Installing Demonstration Versions

If you wish to try ComponentOne Chart for WPF and do not have a serial number, follow the steps through the
installation wizard and use the default serial number.

The only difference between unregistered (demonstration) and registered (purchased) versions of our products is
that registered versions will stamp every application you compile so a ComponentOne banwél not appear
when your users run the applications.

UninstallingChart for WPF
To uninstall ComponentOne Chart for WPF :
1. Open theControl Panel and selectAdd or Remove Programs(Programs and Featuresn Vista).

2. SelectComponentOne Studio for WPF and dick the Remove button.

3. Click Yesto remove the program.

EndUser License Agreement

All of the ComponentOne licensing information, including the ComponentOne endiser license agreements, the
ComponentOne licensing model, and frequently asked licensing qtiess, is available online at
http://www.componentone.com/SuperPages/Licensing/ .

Licensing FAQs

This section describes the main technical aspects of licensing. It may help ther te@inderstand and resolve
licensing problems he may experience when using ComponentOne .NET and ASP.NET products.

What is Licensing?

Licensing is a mechanism used to protect intellectual property by ensuring that users are authorized to use software
products.

Licensing is not only used to prevent illegal distribution of software products. Many software vendors, including
ComponentOne, use licensing to allow potential users to test products before they decide to purchase them.

Without licensing, this typeof distribution would not be practical for the vendor or convenient for the user.
Vendors would either have to distribute evaluation software with limited functionality, or shift the burden of
managing software licenses to customers, who could easily forgieat the software being used is an evaluation
version and has not been purchased.

How does Licensing Work?

ComponentOne uses a licensing model based on the standard set by Microsoft, which works with all types of
components.
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Note : The Compact Framework components use a slightly different mechanism for run -time licensing than the
other ComponentOne components due to platform differences.

When a user decides to purchase a product, he receives an installation program and a Serial Number. During the
installation process, the user is prompted for the serial number that is saved on the system. (Users can also enter
the serial number by clicking thd.icense button on the About Box of any ComponentOne product, if available, or
by rerunning the installation and ergring the serial number in the licensing dialog.)

When a licensed component is added to a form or Web page, Visual Studio obtains version and licensing
information from the newly created component. When queried by Visual Studio, the component looks for
licensing information stored in the system and generates a ftime licenseand version information, which Visual
Studio saves in the following two files:

1 Anassembly resource file which contains the actual rdime license
1 A"licenseslicx" file that contains the licensed component strong name and version information
These files are automatically added to the project.

In WinForms and ASPNET 1.x applications, the runtime licenseis stored as an embedded resource in the
assembly hosting the component oromtrol by Visual Studio. In ASPNET 2.x applications, the runtime license
may also be stored as an embedded resource in the App_Licenses.dll assembly, which is used to store -dilhmein
licenses for all components directly hosted ByebFormsin the application. Thus, the App_licenses.dll must
always be deployed with the application.

The licenses.licx file is a simple text file that contains strong names and version information for each of the
licensed components used in the application. Whenever Visualugito is called upon to rebuild the application
resources, this file is read and used as a list of components to query fortiore licenses to be embedded in the
appropriate assembly resource. Note that editing or adding an appropriate line to this file darce Visual Studio
to add runtime licenses of other controls as well.

Note that the licenses.licx file is usually not shown in the Solution Explorer; it appears if you press Steow All
Files button in the Solution Explorer's toolbox, or from Visual 8udio’s main menu, selecEhow All Files on the
Project menu.

Later, when the component is created at run time, it obtains the rttime licensefrom the appropriate assembly
resource that was created at design time and can decide whether to simply acdeptar-time license, to throw an
exception and fail altogether, or to display some information reminding the user that the software has not been
licensed.

All ComponentOne products are designed to display licensing information if the product is not liceats None will
throw licensing exceptions and prevent applications from running.
Common Scenarios

The following topics describe some of the licensing scenarios you may encounter.

Creating components at design time

This is the most common scenario and alstié simplest: the user adds one or more controls to the form, the
licensing information is stored in the licenses.licx file, and the component works.

Note that the mechanism is exactly the same for Windows Forms and Web Forms (ASP.NET) projects.

Creating conponents at run time

This is also a fairly common scenario. You do not need an instance of the component on the form, but would like
to create one or more instances at run time.

In this case, the project will not contain a licenses.licx file (or the filill not contain an appropriate rurnttime
license for the component) and therefore licensing will fail.
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To fix this problem, add an instance of the component to a form in the project. This will create the licenses.licx file
and things will then work as expeted. (The component can be removed from the form after the licenses.licx file
has been created).

Adding an instance of the component to a form, then removing that component, is just a simple way of adding a
line with the component strong name to the liceses.licx file. If desired, you can do this manually using notepad or
Visual Studio itself by opening the file and adding the text. When Visual Studio recreates the application resources,
the component will be queried and its rusime license added to the gpropriate assembly resource.

Inheriting from licensed components

If a component that inherits from a licensed component is created, the licensing information to be stored in the
form is still needed. This can be done in two ways:

1 Add a LicenseProvider attibute to the component.

This will mark the derived component class as licensed. When the component is added to a form, Visual
Studio will create and manage the licenses.licx file, and the base class will handle the licensing process as
usual. No additiona work is needed. For example:

[LicenseProvider(typeof(LicenseProvider))]

class MyGrid: C1.Win.C1FlexGrid.C1FlexGrid

{
}

1 Add an instance of the base component to the form.

...

This will embed the licensing information into the licenseBcx file as in the previous scenario, and the
base component will find it and use it. As before, the extra instance can be deleted after the licenses.licx
file has been created.

Please note, that C1 licensing will not accept a run time license for a dexdvcontrol if the run time license is
embedded in the same assembly as the derived class definition, and the assembly is a DLL. This restriction is
necessary to prevent a derived control class assembly from being used in other applications without a désign
license. If you create such an assembly, you will need to take one of the actions previously described create a
component at run time.

Using licensed components in console applications

When building console applications, there are no forms to add cgranents to, and therefore Visual Studio won't
create a licenses.licx file.

In these cases, create a temporary Windows Forms application and add all the desired licensed components to a
form. Then close the Windows Forms application and copy the licensestifile into the console application
project.

Make sure the licenses.licx file is configured as an embedded resource. To do this, fidilok the licenses.licx file in
the Solution Explorer window and selecProperties. In the property window, set theBuil d Action property to
Embedded Resource

Using licensed components in Visual C++ applications

There is an issue in VC++ 2003 where the licenses.licx is ignored during the build process; therefore, the licensing
information is not included in VC++ applications.

To fix this problem, extra steps must be taken to compile the licensing resources and link them to the project. Note
the following:

1. Build the C++ project as usual. This should create an exe file and also a licenses.licx file with licensing
information in it.

2. Copy the licenses.licx file from the app directory to the target folder (Debug or Release).
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3. Copy the ClLc.exe utility and the licensed dlls to the target folder. (Don't use the standard Ic.exe, it has
bugs.)

4. Use ClLc.exe to compile the licenses.bcfile. The command line should look like this:
cllc /target:MyApp.exe /complist:licenses.licx /i:C1.Win.C1FlexGrid.dll

5. Link the licenses into the project. To do this, go back to Visual Studio, riglstick the project, select
properties, and go to the Likker/Command Line option. Enter the following:
/ASSEMBLYRESOURCE:DebugMyApp.exe.licenses

6. Rebuild the executable to include the licensing information in the application.

Using licensed components with automated testing products

Automated testing products hat load assemblies dynamically may cause them to display license dialogs. This is
the expected behavior since the test application typically does not contain the necessary licensing information, and
there is no easy way to add it.

This can be avoided by dding the string "C1CheckForDesignLicenseAtRuntime" to the AssemblyConfiguration
attribute of the assembly that contains or derives from ComponentOne controls. This attribute value directs the
ComponentOne controls to use design time licenses at run time.

For example:
#if AUTOMATED_TESTING
[AssemblyConfiguration("C1CheckForDesignLicenseAtRuntime")]

#endif
public class MyDerivedControl : C1LicensedControl
{
I ...
}

Note that the AssemblyConfiguration string may contain additional text before or aftéine given string, so the
AssemblyConfiguration attribute can be used for other purposes as well. For example:
[AssemblyConfiguration("C1CheckForDesignLicenseAtRuntime,BetaVersion")]

THIS METHOD SHOULD ONLY BE USED UNDER THE SCENARIO DESCRIBED. It requires a design
time license to be installed on the testing machine. Distributing or installing the license on other computers is a
violation of the EULA.

Troubleshooting

We try very hard to make the licensing mechanism as unobtrusive as possible, but probleray wccur for a
number of reasons.

Below is a description of the most common problems and their solutions.

| have a licensed version of a ComponentOne product but | still get the splash screen when | run my
project.

If this happens, there may be a problemith the licenses.licx file in the project. It either doesn't exist, contains
wrong information, or is not configured correctly.

First, try a full rebuild (Rebuild All from the Visual StudioBuild menu). This will usually rebuild the correct
licensing resouces.

If that fails follow these steps:
1. Open the project and go to the Solution Explorer window.
2. Click the Show All Files button on the top of the window.

3. Find the licenses.licx file and open it. If prompted, continue to open the file.
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4. Change the versiomumber of each component to the appropriate value. If the component does not
appear in the file, obtain the appropriate data from another licenses.licx file or follow the alternate
procedure following.

5. Save the file, then close the licenses.licx tab.
6. Rebuild the project using theRebuild All option (not just Rebuild).
Alternatively , follow these steps:
1. Open the project and go to the Solution Explorer window.
Click the Show All Files button on the top of the window.
Find the licenses.licx file and delete it
Close the project and reopen it.
Open the main form and add an instance of each licensed control.

o g A~ w DN

Check the Solution Explorer window, there should be a licenses.licx file there.
7. Rebuild the project using theRebuild All option (not just Rebuild).

For ASP.NET 2.x applications, follow these steps:
1. Open the project and go to the Solution Explorer window.
2. Find the licenses.licx file and righiclick it.
3. Select the Rebuild Licenses option (this will rebuild the App_Licenses.licx file).
4. Rebuild the project usirg the Rebuild All option (not just Rebuild).

| have a licensed version of a ComponentOne product on my Web server but the components still
behave as unlicensed.

There is no need to install any licenses on machines used as servers and not used for develdpme

The components must be licensed on the development machine, therefore the licensing information will be saved
into the executable (exe or dll) when the project is built. After that, the application can be deployed on any
machine, including Web servers.

For ASP.NET 2.x applications, be sure that the App_Licenses.dll assembly created during development of the
application is deployed to the bin application bin directory on the Web server.

If your ASP.NET application useswWinForms user controls with constitient licensed controls, the runtime license
is embedded in theNinForms user control assembly. In this case, you must be sure to rebuild and update the user
control whenever the licensed embedded controls are updated.

| downloaded a new build of a compotteat | have purchased, and now I'm getting the splash screen
when | build my projects.

Make sure that the serial number is still valid. If you licensed the component over a year ago, your subscription
may have expired. In this case, you have two options:

Option 1 - Renew your subscription to get a newserial number.

If you choose this option, you will receive a new serial number that you can use to license the new components
(from the installation utility or directly from the About Box).

The new subscrigion will entitle you to a full year of upgrades and to download the latest maintenance builds
directly from http://prerelease.componentone.com/.

Option 2 & Continue to use the components you tave.
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Subscriptions expire, products do not. You can continue to use the components you received or downloaded while
your subscription was valid.

Technical Support

ComponentOne offers various support options. For a complete list and a description oiséable, GomponentOne
Web site ahttp://www.componentone.com/SuperProducts/SupportServices/

Some methods for obtaining technical support include:

1 Online Resources

ComponentOne provides customers with a comprehensive set of technical resources in the form of FAQs,
samples and videos, Version Release History, searchable Knowledge base, searchable Online Help and
more. We recommend this as the first place to look for answers to your technical questions.

1  Online Support via our Incident Submission Form

This online support service provides you with direct access to our Technical Support staff visoatine
incident submission form When you submit an incident, you'll inmediately receive a response vianeail
confirming that you've successfully created an incide This e-mail will provide you with an Issue
Reference ID and will provide you with a set of possible answers to your question from our
Knowledgebase. You will receive a response from one of the ComponentOne staff members wvisad in
2 business days dess.

1 Product Forums

Co mp o n e nprdductEfdiusns are available for users to share information, tips, and techniques

regarding ComponentOne products. ComponentOne developers will be availalon the forums to share
insider tips and techniqgue and answer usersd quest.i
required to participate in the ComponentOne Product Forums.

1 Installation Issues

Registered users can obtain help with problenisstalling ComponentOne products. Contact technical
support by using theonline incident submission formor by phone (412.681.4738). Pleasete that this
does not include issues related to distributing a product to enders in an application.

1 Documentation

Microsoft integrated ComponentOne documentation can be installed with each of our products, and
documentation is also available online. Iffou have suggestions on how we can improve our
documentation, please email th®ocumentation team Please note that €nail sent to theDocumentation
teamis for documentation feedback onlyTechnical Supportand Salesissues should be sent directly to
their respective @partments.

Note: You must create a ComponentOne Account and register your product with a valid serial number to obtain
support using some of the above methods.

Redistributable Files

ComponentOne Chart for WPF is developed and published by ComponentOne LLCYou may use it to develop
applications in conjunction with Microsoft Visual Studio or any other programming environment that enables the
user to use and integrate the control(s). You may also distribute, free of royalties, the following Redistributable
Files with any such application you develop to the extent that they are used separately on a single CPU on the
client/workstation side of the network:

1 C1.WPF.Cl1Chart.dll
1 C1.WPF.ClChart.Extended.dll
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Note: Both the CLWPF.C1 Chart .dll and CL.WPF.C1 Chart .Expres sion.Design.dll files are installed to C:\ Program

Files \ ComponentOne \ Studio for WPF \ bin by default. The C1.WPF.C1 Chart .Expression.Design.dll installed
with Chart for WPF for WPF should always be placed in the same fold erasthe C1LWPF.C1 Chart .dll ; thesefi les
should NOT be placed in the GAC. The CLWPF.C1 Chart .Expression.Design.dll assembly is required by Blend.

Site licenses are available for groups of multiple developers. Please con&ates@ComponentOne.confor details.

AboufThisDocumentation

You can create yourchart applications using Microsoft Expression Blend or Visual Studid008 but Blend is
currently the only designatime environment that allows users to design XAML documents visually.
Acknowledgements
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XAML andAMINamespaces

XAML is a declarative XML-based language that is used as a useteifiace markup language in Windows
Presentation Foundation and the .NET Framework 3.0With XAML you can create a graphically rich customized
user interface, perform databinding, andhuch more. For more information on XAML and the .NET Framework
3.0, plea® seenttp://www.microsoft.com .

XAML Namespaces

Namespaces organize the objects defined in an assembly. Assemblies can contain multiple namespaces, which can
in turn contain other namespaces. Namespacpsevent ambiguity and simplify references when using large groups
of objects such as class libraries.

When you create a Microsoft Blend project, a XAML file is created for you, and some initial namespaces are
specified:

Namespace Description

xmins="http  ://schemas.microsoft.com/win This is the default Windows Presentation Foundation

fx/2006/xaml/presentation” namespace.

xmins:x="http://schemas.microsoft.com/ This is a XAML namespace that is mapped to the x: prefix.

winfx/2006/xaml" The x: prefix provides a quick, easy way to reference the
namespace, which defines many commonly -used features

necessary for WPF applications.
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When you add aC1Chart control to the window in Microsoft Expression Blend,Blend automatically creaes a clr
namespace, or common language runtime (CLR) namespace that maps to the C1.WPFCBart assembly. The
namespace looks like the following:

xmlins:clchart="http://schemas.componentone.com/xaml/clchart"

The clr-namespace value i€1.WPF.C1 Chart, and the assembly value i€1.WPF.C1 Chart.

When you add aC1Chart control to the window in Visual Studio 2008, Visual Studio automatically creates a elr
namespace, or common run time (CLR) namespace that maps to t6&.WPF.C1Chart assembly. The namespace
looks like the following:

xmlins:clchart="http://schemas.componentone.com/xaml/clchart"

You can also choose to creatgour own custom name for the namespacéor example
xmins:MyC1 Chart ="clr - namespace:C1.WPF.C1 Chart ;assembly=C1.WPF.C1 Chart "

Y ou can now use your astom namespace when assigning properties, methods and events.

Creating a Microsoft Blend Project

To create a new Blend project, complete the following steps:

1. From the File menu, selectNew Project or click New Project in the Blend startup window. TheCreate
New Project dialog box opens.

2. Select theWPF Application (.exe) , and enter a name for the project in théName text box.

The WPF Application (.exe) creates a project for a Windowsased application that can be built and run
while beingdesigred.

w

Selectthe Browse button to specify a location for the project.

e

Select a language from theanguagedrop-down box and click OK .

WPF Control Silverlight 1.0
Library Site

C1WPFChart

C:\Expression Blend Projects

Visual C# w

.NET Framework v3.5 w

A new Blend project with aXAML window is created.
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Creding a .NEMrojecin Visual Studio

To create a new .NET projectopen Visual Studio 2008 anadomplete the following steps:

1. From the File menu in Microsoft Visual Studio 2008, seledew Project. The New Project dialog box
opens.

2. Choose the appropriateNET Framework from the drop-down box in the top-right of the dialogbox.

3. Under Project Types, selecteither Visual Basic or Visual C# .

Note: In Visual Studio 2005 select NET Framework 3.0 under Visual Basic or Visual C# in the Project
types tree.

4. SelectWPF Application from the list of Templatesin the right pane.

MET Framework 3.5

Project bypes: Templates:

Database # || ¥isual Studio installed templates
Reporting
Tesk (#] Windows Forms Application (] Class Library
WiCF 4 WPF Application [5z|'WPF Browser Application
‘WarkFlow - Clagsole Application [ Empty Praject

(=1 Wisual Cit LA windows Service & WPF Cushomn Conkral Librar
Windows [&#| WPF User Control Library 7] windows Forms Control Lib
Web
Smart Device My Templates

Office T

Datahase _:l Search Online Templates. ..

5. Enter a namefor your application in the Name field and click OK . A new Microsoft Visual Studio .NET
WPF project is creaéd with a .xaml file that will be usedto define your user interface and commands in

the application.

Note: You can create your chart applications using Microsoft Expression Blend or Visual Studio , but Blend is
currently the only desig  n-time environmentt  hat allows users to design XAML documents visually

Creating an XAML Browser Application (XBAP) in Visual Studio

To create a new XAML Browser Application (XBAP) in Visual Studio 2008, complete the following steps:
1. From the File menu in Microsoft Visual Sudio 2008, selectNew Project. The New Project dialog box
opens.

2. Choose the appropriate .NET Framework from the Framework droplown box in the topright of the
dialog box.
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MET Framewark 3.5 ~| (2 |
MET Framewark 2,0
| MET Framework 3.0

MET Framewaork 3.5
1| Class Torary

.';J'E_TISiI'-.-'erIight Project

asp MFET WWeh Service Annlicatinn

Under Project types select eitheVisual Basic or Visual C# .

4. ChooseW PF Browser Application from the list of Templatesin the right pane.

Note: If using Visual Studio 2005, you may need to select XAML Browser Application (WPF) after
selecting NET Framewor k3.0 under Visual Basic or Visual C# inthe left -side menu.
5. Enter a name for your application in theName field and click OK .

A new Microsoft Visual Studio .NET WPF Browser Application project is created with a XAML file that
will be used to define youwser interface and commands in the application.

When you run this application to a Web server, users can locate the URL and run your program from within the
IE Sandbox.

Note: The XAML Browser Application only works in IE 6 or IE 7.

AddingheChart for WA-Components to a Blend Project

In order to useC1Chart or another Chart for WPF componentin the Designworkspaceof Blend, you must first
add a reference to th€1.WPF.C1 Chart assembly and then add the component from Bldis Asset Library.

To add a reference to the assembly:
1. Click on Project | Add Reference.
2. Browse to find theC1.WPF.C1 Chart.dll installed with Chart for WPF.

Note: The C1.WPF.C1Chart.dll is installed to C:\ Program Files \ ComponentOne \ Studio for WPF \ bin
by de fault.
3. SelectC1.WPF.C1Chart .dll and click Open. A reference is added to your project.
To add a component from the Asset Library:

1. Once you have added a reference to tl&l.WPF.C1 Chart assembly, click theAsset Library button in
the Blend toolbox.The Asset Library appears.

2. Click the Custom Controls tab. All of the Chart for WPF main and auxiliary componentsare listedhere.

3. SelectC1Chart from the Asset Library dialog box. The componentappears in theT oolbox above the
Asset Library button.

4. Double-click the C1Chart component in theToolbox to add it to theWindowl.xaml.

24



Adding th€hart for WRFomponents to a Visual Studio Project

When you install Chart for WPF the C1Chart control should be added to your Visual Studio Todlox. You can
also manually add ComponentOne controls to the Toolbox.

ComponentOne Chart for WPF provides the following controk:
f CiChart
1 CiChartLegend

To useChart for WPF , addthe CChartcontrol to the window or add a reference to th€1.WPF.C1 Chart
assenbly to your project.

Manually Adding Chart for WPF to the Toolbox
To manually add theC1Chart control to the Visual Studio Toolbox, complete the following steps:

1. Open the Visual Studio IDE (Microsoft Development Environment). Make sure the Toolbox is visié
(selectToolbox in the View menu, if necessary) and rightlick the Toolbox to open its context menu.

2. To make Chart for WPF , C1Chart component appear on its own tab in the Toolbox, seleétdd Tab
from the context menu and type in the tab nameChart for WPF, for example.

3. Right-click the tab where the component is to appear and sel€toose Itemsfrom the context menu.
The Choose Toolbox Items dialog box opens.

4. In the dialog box, select theNPF Components tab. Sort the list by Namespace (click thlamepace
column header) and select the check boxes for all components belonging to the C1.WPEGArt
namespace. Note that there may be more than one component for each nhamespace.

Choose Toolbox ltems

MET Framework Components | COM Companents | WPF Components | Activities

Mame Mamespace Aszembly Name

[] BulletDecorator System. Windows, Controls.Prim...  PresentationFramey
|:| Button System. Windows, Controls PresentationFramey
[] ButtonChrome Microsoft. Windows. Themes PresentationFramey
[] ButtonChrome Microsoft. Windows. Themes PresentationFramey
[ ] ButtonChrome Microsoft, Windows. Themes PresentationFramey
C1Chart C1.WPF.C1Chart C1.WPF.C1Chart

C1ChartLegend C1.WPF.C1Chart C1.WPF.C1Chart (3
|:| Canvas System. Windows, Controls PresentationFramey
[] checkBox System. Windows, Contraols PresentationFramey

Adding Chart for WPF to the Window
To add Chart for WPF to a window or page, complete the following steps:
1. Add the C1Chart control to the Visual Studio Toolbox.
2. Double-click C1Chart or drag the control onto the window.

Adding a Reference to the Assembly
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To add a reference to th€hart for WPF assembly, complete the following steps:
1. Select theAdd Referenceoption from the Project menu of your project.

2. Select theComponentOne Chart for WPF assembly from the list on theNET tab or on the Browse tab,
browse to find the C1.WPF.CXhart.dll file and click OK.

3. Double-click the window caption area to open the code window. At the top of the file, add the following
Imports statements @sing in C#):
Imports CLWPF.C1 Chart

This makes the objects efined in theChart for WPF assembly visible to the project.

Key Features

Chart for WPF provides the following unique features:
1 Universal and Flexible Data Binding

Easily bind theChart for WPF control to a data table, collection of business objects, or XMile by
setting a few properties.

1 Extend Your Deployment Capabilities with XBAP Support

Chart for WPF is fully compatible with the new XBAP deployment capabilities of Windows Presentation
Foundation. The XBAP depl oy me ndupperted) wowser fgrafull i shi ng t
featured application without a Windows installation.

1 Choose From Over 35 Built-in Chart Types

Choose from the standard chart types (bar charts, line charts, pie charts, area charts, and more) or select
from more advanced chartypes such as a 3D doughnut pie or 3D ribbon.

1 Improve the Readability of Your Chart with Data Labels

Highlight important data points and provide valuable data information by adding data labels on each data
series. There is no limit to the number of datkabels a chart can contain.

1 Charts That Come Alive with ToolTips

Display specific text when the user mouses over chart elemer@hart for WPF gives you the control to
format the information displayed in the ToolTip.
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Display Highly Representative Data with Multiple Axes

Place multiple axes to the top, bottom, left, or right of the chart to create a more detailed representation of
data.
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JayuRIye

Highly Interactive End -user Experience

Chart for WPF provides a wide range of interactive behaviors ranging from buitt tools such as
scrolling, scaling, and rotating charts at run time.

Display Large Amounts of Data with Axis Scrolling

Use theScaleand Value properties to enable scrolling along the chart axes. This is helpful when you have
large amounts of X or Y data to display.
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Create Dramatic Data Presentation with Multiple Charts

Chart for WPF allows you to combine various chart types, on a single plot, to create dramatic data
presentation.

Highly Customizable Plot Elements

Quickly and efficiently change the appearance of any plot element using the symbol and connection
properties.

Create a Wealth of Custom Palettes for Plot Elements

Experience more customizing options for plot elements; you are not restricted to a predefineceftal For
example, use theCustomPaletteproperty to define various brushes for plot elements.

Industry Leading Stacking Charts
Line, area, bar, and column charts can be stacked to display more complex data in a smallecspa

12 built -in themes available, giving you the means to achieve colorful, professionatlooking
applications

Customize the appearance of your chart application with builh Office 2007, Vista, and Office 2003
themes, or create your own themes based oretincluded themesYour polished chart is just a click away.
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1 Enhanced graphic effects

Add some flair to your chart by enabling bitmap effects such as bevel, shadow, blur, glow, and emboss.
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Chart for WPF Quick Start

The following quick start guide is intended to get you up and running wit€hart for WPF . This quick start will
guide you through the four basic steps for creating a typical chart such as a Bar chart: choose the chart, add one or
more data series to the chart, set up and format the axes, and adjust the ¢hagpipearance using th€heme

property.

Step 1 of 4: Adding Chart for WPF to your Project

In this step you'leither begin in Visual Studio @lend to create a chart application us@igart for WPF . When you
add theCl1Chartcontrolo your Vi sual Studio or Blend projectifyoudll
you use XAML code only to i ni enptyctharznwithoy thauifakedata.ar t contr ol

To add Chart for WPF to your Visual Studio Project using XAML :
1. Create a new WPF project in Visual Studio

2. Add areference to theC1.WPF.C1Chart assembly. In the Solution Explorer rightlick on References
and selectAdd Reference In the Add Referencedialog box select the Browse tab. Browse for the
C1.WPF.C1Chart.dll and selectOK.

3. Define the Systemand theC1.WPF.C1Chart prefixes.
xmins:System="clr - hamespace:System;assembly=mscorlib"
xmins:clchart="clr -
namespac e:C1.WPF.C1Chart;assembly=C1.WPF.C1Chart"

4. Inside the Grid, initialize the C1Chart control.
<clchart :CiChart Margin ="0,0,8,8" MinHeight ="160" MinWidth ="240"
Content ="Cl1Chart">
</ clchart : ClChart >

The chart appears empty since we did not add the data for ity
In the next step,Step 2 of 4: Adding Data to the Char{page32), you will add the data for C1Chart.
To add Chart for WPF to your Blend Project:
1. Create a new WPF poject in Blend.

2. Add the C1Chart control to your window.
The C1Chart control is added to the Window.
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The default"fake" data is added to the Chart control.
<my:C1 Chart Margin="10,10,68,102" Name="c1Chart1">
<my:C1Chart.Data>
<my:ChartData>
<my:ChartData.ltemNames>P1 P2 P3 P4
P5</my:ChartData.ltemNames>
<my:DataSeries Label="Series 1" Values="20 22 19 24
25" >
<my:DataSeries Label="Series 2" Values="8 12 10 12 15"
/>
</my:ChartData>
</my:C1Chart.Data>
<my:C1ChartLegend DockPanel.Dock="Right" />
</my:C1Chart>

3. Resize theC1Chart control so it fills up the Window.
In the next step,Step 2 of 4: Adding Data to the Char{page32), you will add the data for C1Chart.

Run the program and observe:

The C1Chart control will appear like the following if you added the chart control to your Blend or Visual Studio
project. If you just added the Chart control using XAML code then the Chart will appear empty since default data
was not added to it.
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You've successfully created ehart application. In the next step youodl ClCattst omi ze€
control.

Step 2 of 4: Adding Data to the Chart

In the lag step, you added theC1Chart control to the Window. In this step, you will add aDataSeriesobject and
data for it.

32



To add data to the chart in Visual Studio using XAML

1. SettheChartType property to Bar within the "<clchar t:C1Chart></clchart:C1Chart> "tag
using the following XAML code:
ChartType="Bar"

2. Add the data for the chart control using the following XAML code:
<clchart:C1Chart.Data>
<clchart:ChartData>
<clchart:ChartData.ltemNames>
<x:Array Type="{x:Type System:String}">
<System:String>Hand Mixer</System:String>
<System:String>Stand Mixer</System:String>
<System:String>Can Open er</System:String>
<System:String>Toaster</System:String>
<System:String>Blender</System:String>
<System:String>Food Processor</System:String>
<System:String>Slow Cooker</System:String>
<System:String>Microwave</System:String>
</x:Array>
</clchart:ChartData.ltemNames>
<clchart:DataSeries Values="80 400 20 6 0 150 300 130
500" AxisX="Price" AxisY="Kitchen Electronics" Label="Price"/>
</clchart:ChartData>
</clchart:C1Chart.Data>

In this step we use on®ataSeriesthat has eight Xvalues. We addedtemNames of the type string to the
ChartData to represent the sing name for each data valueWe used an array of string names for the
IltemNames since a few of the item names included spaces. We were able to use the System:String
namespace since we declared the namespace for it in step 8tep 1 of 4: Adding Chart for WPF to your
Project (page31).

The new data appears on the chart like the following:

Microwawver

Tt

Slow Cooker

Food Processor }

Blendery

Toaster:

Can Cpenery

Stand Mixery

Hand Mixer

T

S0 100 150 200 250 300 350 400 450 500

In the next step,Step 3 of 4: Format the Axegpage38), youd |l | l earn how to cust ol
XAML code.
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To add data to the chart in Blend using the Properties Window

1. SelecttheClChart control in the Window to make it active, then navigate to the Appearance tab in the

Chart Propertie s window and set theChartType property to Bar.
Navigate to theMiscellaneous tab in the Chart Properties window.

In the Miscellaneous tab, locate the Data (ChartData) and click on th&lew button. The chartdata object
is added in the xaml code like the following:
<clchart:C1Chart MinHeight="160" MinWidth="240" Content="C1Chart"
Margin="0,0,24, 8">

<clchart:C1Chart.Data>

<clchart:ChartData/>
</clchart:C1Chart.Data>
<clchart:C1ChartLegend DockPanel.Dock="Right"/>
</clchart:C1Chart>

The fake chart data is removed and the C1Chart control appears empty since you have not added any data
to it yet.

Click on the arrow in the C1Chart properties window next to Data (ChartData) to expand th€hartData
properties. Click on the ellipsis button next to the Children (Collection) property. ThBataSeries
Collection Editor: Children dialog box appears.

DataSeries Collection Editor: Children

Itemns Properties

f * Add ancther item

5. Click Add another item button to add a type of data series to thBataSeriesCollection

The Select Object dialog box appears.
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10.

11.

12.

13.

Select Object

Select the class to create an instance of

CLWPF.C1Chart
CLWPF.C1Chart
’.

% BubbleSeries
"5 DataSeries

*¢ HighLowOpenCloseSeries

#+  HighLowSeries

¢ YyDataSeries
#+ XYZDataSeries

In the Select Objectdialog box you can choose one of the following chart objectBi{bbleSeries
DataSeries HighLowOpenCloseSeries HighLowSeries, XYDataSeries XYZDataSeries) depending m
what type of chart you would like to create. To create Bar chart, you would use theDataSeries Once
you select theDataSeriesobject, it is added to theDataSeriesCollection. To add multiple series you can
click the Add another item button

SelectDataSeriesfrom the Select Objectdialog box and clickOK .
The [0] DataSeries object is added to the Items panel.

Next we will add values that will represent the price of each product. Click on the ellipsis button next to
the Values (Collection) to bring up tle Double Collection Editor: Values

Here you can add values. In this example we will click th&dd another item button eight times to add
eight values to our series.

Select the first array and double click the rectangular box in the Properties pane toeetihe value, 80. Do
the same for the remaining values and enter the following values respectively, 400, 20, 60, 150, 300, 130,
and 500. ClickOK when you are finished.

The XAML code appears like the following:
<clchart:C1Chart.Data>
<clchart:ChartData >
<clchart:DataSeries Values="80 400 20 60 150
300 130 500"/>
</clchart:ChartData>
</clchart:C1Chart.Data>

Next we will add y values. Click on the ellipsis button next to the Values (Collection). THaouble
Collection Editor:Values appears.

Click on Add another item button four times to add four yvalues to the first series. For the first y value
enter 1, for the second y value enter 2, for the third y value enter 3, for the fourth y value enter 4. Once
you are finished entering the yalues clck OK to close the collection editor.

Navigate to the Appearance section iChartTydepropartyt 6 s
and change it to Bar.

Run the project and you will have a simpl&ar chart with one ries that looks like the following:
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14. Expand the Data tab and locate thdtemNames property. Enter the following names in this ader: "Hand
Mixer, Stand Mixer, Can Opener, Toaster, Blender, Food Processor, Slow Cooker, and Microwave.
Press the Enter key and then go back and make any modifications if needed in the XAML code. The
XAML code should appear like the following:
<clchart: ChartData.ltemNames>

<x:Array Type="{x:Type

System:String}">

<System:String>Hand
Mixer</System:String>

<System:String>Stand
Mixer</System:String>

<System:String>Can
Opener</System:String>

<System:String>Toaster</System:Str ing>

<System:String>Blender</System:String>
<System:String>Food
Processor</System:String>
<System:String>Slow
Cooker</System:String>

<System:String>Microwave</System:String>
</x:Array>
</clchart:ChartData.ltemNames>

In the next stepStep 3 of 4: Format the Axe¢page38), youd |l | l earn how to
XAML code.

To add data to the chart programmatically in the code behind file
1. Create a new WPF project in Visual Studio
2. Add the C1Chart control to Window1.
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Right-click on Window1 and selectView Code to open the editor.
Add the C1.WPF.C1Chart namespace directive

il

Add the following code in the constructorWindowl class to create the Bar chart:

il

Visual Basic
Imports C1.WPF.C1Chart

C#
using CLWPF.C1Chart ;

Visual Basic

' Clear previous data
clChartl.Data.Children.Clear()

' Add Data
Dim ProductNames As String() = {"Hand Mixer", "Stand Mixer", "Can
Opener", "Toaster", "Blend er", "Food Processor", _

"Slow Cooker", "Microwave"}
Dim PriceX As Integer() = {80, 400, 20, 60, 150, 300, _
130, 500}

' create single series for product price
Dim ds1 As New DataSeries()
dsl.Label = "Price X"

'set price data
dsl1.ValuesSource = P riceX

" add series to the chart
clChartl.Data.Children.Add(ds1)

'add item names
clChartl.Data.ltemNames = ProductNames

' Set chart type
clChartl.ChartType = ChartType.Bar

C#

/I Clear previous data
clChartl.Data.Children.Clear();

/[Add D ata
string[] ProductNames = { "Hand Mixer", "Stand Mixer", "Can Opener",

"Toaster", "Blender", "Food Processor", "Slow Cooker", "Microwave" };
int[] PriceX = { 80, 400, 20, 60, 150, 300, 130, 500 };

/I create single series for product price
DataSeries ds1 = new DataSeries();
dsl.Label = "Price X";
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/Iset price data
dsl1.ValuesSource = PriceX;

/I add series to the chart
clChartl.Data.Children.Add(ds1);

/I add item names
clChartl.Data.ltemNames = ProductNames;

/l Setcha  rttype
clChartl.ChartType = ChartType.Bar;

In the next step,Step 3 of 4: Format the Axe¢page38), youdl | [ earn how to cust ol
programmatically

Run the program and observe:

The string values appear on the YAxis like the following:

Window1

Microwawves

Slow Cooksry ]

Food Processor

Blender ]

Toaster

Can COpener

Stand Mixerd ]

Hand Mixer

20 40 60 80 100120140160180200220240260280 200320340 350380400420440460480500

Noticethe X-Axi s begins with 20 by def atomizetheAxes.t he next set

You have successfully added data to the chart control

Step 3 of 4: Format the Axes

In this step, you will add €hartView object so you can customize theAXis.
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To format the axes for Chart for WPF in Visual Studio using XAML:
1. Add the ChartView object so you can set titles for the 2Axis and Y-axis

The ChartView object represents the area of the chdhat contains data (including the axes). For more
information on the chart axes, se@dxes (page98). The axis titles are UIElement objects rather than simple
text. In this example we will useTextBlock elements to assign the text to the -Xxis and Y-Axis titles.
Once we add theTextBlock element we can then format the text by changing its foreground color and
aligning it to the center.
<clchart:C1Chart >
<clchart:C 1Chart.View>
<clchart:ChartView>
<clchart:ChartView.AxisX>
<clchart:Axis>
<clchart:Axis.Title>

<TextBlock Text="Price" TextAlignment="Center"
Foreground="Crimson" />
</clchart:Axis. Title>

</clchart:Axis>
</clchart:ChartView.AxisX>
<clchart:ChartView.AxisY>
<clchart:Axis>
<clchart:Axis.Title>
<TextBlock Text="Kitchen Electronics"
TextAlignment="Center" Foregroun d="Crimson" />
</clchart:Axis.Title>
</clchart:Axis>
</clchart:ChartView.AxisY>
</clchart:ChartView>
</clchart:C1Chart.View>
</clchart:C1Chart>

2. Configure the value of theX-Axis to start at zero and chage the default AxisXMajor Unit unit value from
50 to 20. Also set theAutoMin property to False so we can have the value begin at zero instead of the
minimum data value. Your XAML code for the View object should now appear like the following:
<clchart:C1Chart.View>

<clchart:ChartView>
<clchart:ChartView.AxisX>
<clchart:Axis Min="0" Max="500" MajorUnit ="20"
AutoMin="False">
<clchart:Axis.Title>
<TextBlock Text="Price"
TextAlignment="Center" Foreground="Crimson" />
</clchart:Axis.Title>
</clcha rt:Axis>
</clchart:ChartView.AxisX>
<clchart:ChartView.AxisY>
<clchart:Axis >
<clchart:Axis.Title>
<TextBlock Text="Kitchen Electroni cs
TextAlignment="Center" Foreground="Crimson" />
</clchart:Axis.Title>
</clchart:Axis>
</clchart:ChartView.AxisY>
</clchart:ChartView>
</clchart:C1Chart.V iew>
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3. Within the <clchart:Axis></clchart:Axis> of the ChartView.AxisX object ®t the AnnoFormat

to change the numeric walues along the »axis to currency and theAnnoAngle property to rotate the X-
Axis annotation to 60 degrees counterclockwise.
<clchart:Axis AnnoFormat ="c" AnnoAngle ="60" />

4. Within the <clchart:Axis></clchart:Axis> of the ChartView.AxisY object set theReversed
property to True to reverse thedirection of the Y-Axis.

In the next step.Step4of4:Adj ust t he Chdgpagedly Appdddadearn how to
chart's appearance using XAML.

To for mat the axes for Chart for WPF programmatically in the code behind file
Add the following code in the constructor Window1 class to format the chart axes:
1 Visual Basic

' set axes titles

ClChartl.View.AxisY.Title = New TextBlock(New Run("Kitchen
Electroni  c¢s"))

Cl1Chartl.View.AxisX.Title = New TextBlock(New Run("Price"))

' set axes bounds
ClChartl.View.AxisX.Min = 0
Cl1Chartl.View.AxisX.Max = 500

' Financial formatting
Cl1Chartl.View.AxisX.AnnoFormat = "c"

' axis annotation rotation
C1Chartl.View.AxisX.AnnoAngle = "60"

1T C#

/Il set axes titles

clChartl.View.AxisY.Title= new TextBlock() { Text = "Kitchen
Electronics" };

clChartl.View.AxisX.Title = new TextBlock() { Text = "Price" };

/I set axes bounds
clChartl.View.AxisX.Min =0;
clChartl.View.AxisX.Max = 500;

/I financial formatting
clChartl.View.AxisX.AnnoFormat = "c";

/I axis annotation rotation
clChartl.View.AxisX.AnnoAngle=60;

In the next step,Step 4 of 4: AdjusttheChat 6 s Ap (pagedd)any @u 81 | |l earn how to
chartds appearance programmatically.

Run the program and observe:

The new format for the axis annotation is applied to the chart.
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I n the next step, I5sappdadarice usingghe onmof the optioms &omctifbante property.

Step 4 of 4: Adjtis¢ Chad Appearance

In this last step, you will adjust the chats appearance using th€heme property.
Toset t he c linavisdaldStudid ubirey KAML:

To specifically define theOffice2007Blue theme in your chart,add the following Theme XAML to the
<clchart:C1Chart> tag so that it appears similar to the following:
<clchart:C1Chart Margin="0,0,8,8" MinHeight="160" MinWidth="240"
Content="C1Chart" ChartType="Bar" ThemeOffice2007Blue">

Tos et c¢ h arihBend usihgdhe Broperties Window
1. Select theC1Chart control in Window1 to make it active.
2. Navigat e t o AppesandedrdiiathetPfoperties window.
3. Click on the dropdown arrow next to theTheme property and selecOffi ce2007Blue
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